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Manual  

The Concept 
Minneola is a calendar that allows you to organise and schedule your life from any networked 
computer that can run a Java virtual machine. You can plan events and schedule your day 
just like any regular calendar. But Minneola is more than that, it allows you to interact with 
friends and plan your social and professional life. Scheduling important business meetings or 
just planning nights out. 
 
The concept of Minneola is designed to match your lifestyle. Just as in life you have different 
social groups or organisations that you are involved in, you have “groups” that you can join 
using Minneola. The group maybe be a University module or your flat mates. To help 
distinguish between the different types of events you are planning or keeping track of each 
group can be organised into multiple calendars. 

Getting Started 
Firstly we would like to thank you for choosing Citrus Minneola to manage your daily life and 
hope you enjoy the experience as much as we have developing it.  

Installation 
If you haven't done so already you'll need to install Minneola Client. See the Installation Guide 
for further details. 

Getting Connected 
Once you've got Minneola Client installed and running you be presented with a login screen. 
The first thing you will need to do is choose a server to store all of your calendars on and 
interact with friends. 
 
• “A friend told me about Minneola” If a friend told you about Minneola ask them what 

server they used. If you don't use the same server as them you won't be able to share 
events and calendars with them. 

• “I found Minneola on my own” If you found Minneola on your own then you have two 
options you can either try one of the public servers from the public server page on the 
Minneola website or setup your own. 

• “I want to run Minneola in my organisation” If you are setting up Minneola in an 
enterprise/academic environment you will want to run your own server to ensure the 
security and privacy of your users as well as the stability of the server. 

 
Once you've found your server type it into the hostname field. 
 
You will then need to enter your username and password; 
• Public Server If the server you are logging into is a public server type any username and 

password into the fields. If the account doesn't exist it will be automatically created, 
otherwise try another username. 

• Private Server You will need to contact an administrator of the server and ask for an 
account. They will provide you with a username and password which you can type into 
the fields. 

 
Finally you can click connect! 

Your first Calendar 
As soon as you've log into Minneola you will be presented with a view of the current month 
and all the events you are subscribed to. To create your first event, choose New Group from 
the file menu and then New Calendar and finally New Event. 
 



For details of how to use these dialogues see the following sections “New/Edit Group” 

Managing your social groups 
Managing your social groups is easy. You can create and join groups by selecting the groups 
option from the tool bar. 
 
For further details see “The Social Tree”, “New/Edit Group Dialog” and the “View Groups 
Dialog” sections. 

Administrating the server 
For further details see the “List Users Dialog” and “List Group Users Dialog” sections. 

Managing profiles and multi-user computers 
For further details see the “Profiles” Section 

Accessing your calendar without networking 
For further details see the “Profiles” Section 

Installation 
Before installing Minneola Client please check that your computer meets the minimum system 
requirements. 
You will need to check that you have the Java Runtime Environment installed on your 
computer. If you are unsure, visit http://www.java.com/en/download/installed.jsp to verify 
weather it is installed. See “Installing Java Runtime Environment” for further details. 

Downloading Minneola Client 
1. Visit http://minneola.sf.net/download.php  
2. Click the download link for your operating system. If you are not using Windows choose 

the JAR version, this will work on any computer with a Java Virtual Machine. 
3. You will be shown a list of links, choose the link which is in a country near to you. 
4. A dialogue box will appear requesting you save the file, save it to your desktop. 

Installing Minneola 
Minneola doesn't have an installer, you just have to download it to your desktop, unzip and 
run. This is so that, even if your not on your own computer, you can get access to your 
calendar as quickly as possible and without any fuss. 
 
1. Unzip the file you downloaded to your desktop. Most versions of Windows and Linux now 

come with build in zip file functionality. If your computer doesn't, you can install WinZip 
from http://www.winzip.com/ 

2. Open the folder which you unzipped Minneola Client into and simply click on 
minneola.exe if you are running windows, otherwise minneola.jar. What can be more 
simple? 

Creating a Shortcut or Launcher 
If you want to be able to access Minneola Client quickly from your desktop you can follow this 
procedure. 
1. Right click on your desktop and choose either New Shortcut or New Launcher. 
2. Browse to the directory which you unzipped Minneola Client to and select either 

minneola.exe or minneola.jar 
3. Click OK. 

http://www.java.com/en/download/installed.jsp
http://minneola.sf.net/download.php
http://www.winzip.com/


Installing Java Runtime Environment 
You may find that you don't have the Java Runtime Environment installed, if this is the case 
you will need to visit the Java download page at http://www.java.com/en/download/ and follow 
instructions. 

System Requirements 
Minneola Client is written purely in Java and therefore requires Java RE to be installed. But 
this does mean that is compatible with any computer able to run a Java virtual machine. Sun 
recommends the following system requirements for Java. 
 
Windows 

• Windows 98 or newer 
• Pentium 166Mhz 
• 32Mb ram 
 

Linux 
• RedHat, Suse, etc 
• Pentium 166Mhz 
• 32Mb ram 
 

For more information see http://www.java.com/en/download/help/sysreq.xml

Interface 

Toolbar 

 
The toolbar allows quick access to the main features of Minneola Client. 
 
Connect: Brings up the login window allowing you to reconnect to another server as a 
different user. 
Groups: Displays a list of groups available to join and gives the option to create your own 
group. 
Create Calendar: Creates a new calendar. 
Create Event: Creates a new event. 
View today: Returns the calendar to today. 
Set view to day: Sets the calendar to display only the current day. 
Set view to whole month: Sets the calendar to display only the an entire month. 

http://www.java.com/en/download/
http://www.java.com/en/download/help/sysreq.xml


Login/Profiles 

 
This is the window that you are presented with as soon Minneola Client is launched. It allows 
you quickly connect to different servers or manage multiple accounts on the same server. 
 
Profile: Allows you to quickly recall previously saved profiles from a combo box. 
Hostname: You must enter the hostname of a Minneola Server. 
Username: You must enter your username for the specified Minneola Server. 
Password: You must enter the password that corresponds with your account. The password 
is masked and so is not displayed on screen. 
Connect: Initiates a connection with the server. If the connection succeeds you will be 
presented in month view otherwise an error message will be displayed. 
Work Offline: Allows you to view your cached calendars in a read-only mode whilst not 
connected to a network. 
Add Profile: This will create a new profile a profile name will be requested. 
Delete Profile: This will remove the currently displayed profile, confirmation is required. 

Mini Calendar 

 
The mini calendar is always visible and allows the user to quickly navigate to different days 
and months in the calendar. By either selecting a date a long way in the future using combo 
boxes or in the current month by double clicking a day on the mini month calendar. 



Social Tree 

 
The social tree is always visible and allows the user to quickly interact with all of their social 
groups. It is displayed in a hierarchical tree format. Groups are shown as top level nodes 
whilst calendars are shown as leaf nodes and highlighted with their calendar colour. 
 
Double clicking the GROUPS node will cause the Group List dialogue to be displayed so that 
you can join existing groups or create a new group. 
 
Double clicking a group will cause the edit group dialogue to be displayed. 
 
Double clicking a calendar will cause the edit calendar dialogue to be displayed. 

Day View 

 
From this screen an entire day is shown in detail. The day being viewed is displayed at the 
top. 
 
The hours of the day are indicated on the left of the window. Events are displayed in the 
hours that they correspond to for the day, if multiple events occur at the same time a further 
column will be created so that the events may be showed simultaneously. Events will be 
coloured according to the calendar they belong to. 
 
Each event shows its title along with a more detailed description. 



 
Double clicking on an event allows you to edit that event, double clicking on a time in the left 
column allows you to create a new event at that time.  
 
It is possible to navigate between days by using the backward and forward icons at the top of 
the window. 

Month View 

 
From this screen an entire month is viewable. The month being viewed is displayed at the top 
of the window. 
 
The window is split up into boxes each of which represents a day. If an event occurs on one 
of the days in the month it will be displayed in the relevant day. The event will also be 
highlighted with a colour which corresponds to its calendar. The calendar colour is set in the 
Edit Calendar dialogue which is accessible from the Social Tree. 
 
Double clicking on an event will allow it to be edited through the Edit Event dialogue. Double 
clicking on a day with out an event will allow you to create a new event. 
 
It is possible to navigate between months by using the backward and forward icons at the top 
of the window. 

New/Edit Group 

 
From this dialogue you can create a new group or edit an existing group. It is accessible from 
the File Menu, Toolbar and also by double clicking a calendar in the social tree. 
 
Group Name: You must give the group a name. It doesn't have to be unique as groups are 
identified by a unique number that isn't shown to the user. This name will be displayed in the 
social tree of each user that is subscribed to the group and in the group list dialogue. It will 



also be selectable from the calendar and event dialogues. For example “Bristol University 
Rowing Club” or “COMS22201 University Module”. 
Group Description: You don't have to choose a description, if you do it should describe the 
nature of the group in a more verbose manner than the name. 
Permissions: You can choose to make the group invite-only; by default it’s accessible by any 
member of the server. If the group is invite-only it can only accessed by: 

• Existing group members 
• Users that you invite 
• Server administrators 

Add/Update: This will add the new group or update changes to the existing group. The 
changes will only be saved if you have the correct permissions, you will be notified via a 
message box if you don't. 
Cancel: This will cause the group to not be created or cancel any change to the existing 
group. 
Remove: Only available when the dialogue is in edit mode. This will remove the group from 
the server and everyone's group social tree. Only the group owner or a server administrator 
can do this. This is permanent! 
Leave: This will cause you to the leave the group. It will no longer be displayed in your social 
tree, any associated calendars and events will no longer be accessible to you. The group will 
continue to exist and you can rejoin it using the List groups option accessible from the toolbar. 

New/Edit Calendar 

 
From this dialogue you can create a new calendar or edit an existing calendar. It is accessible 
from the File Menu, Toolbar and also by double clicking a group in the social tree. 
 
Title: You must give the calendar a title, it should explain the nature of the calendar with the 
group. For example “Coursework deadlines” in for a university deadline or “Birthdays” in a 
friends group. It doesn't have to be unique as calendars are identified by a unique number 
that isn't shown to the user. This title will be displayed in the social tree of each user that is 
subscribed to the calendars group. It will also be selectable from the event dialogue. 
Group: You must select a group to add the calendar too. The list provided is all the groups 
are those which you are subscribed too. 
Calendar Description: You don't have to choose a description, if you do it should describe 
the nature of the calendar in a more verbose manner than the title. 



Permissions: You can choose to make the calendar read-only, by default it’s writeable by 
any member of the group. If the group is read-only it can only be modified by the following 
users: 

• Yourself 
• The group owner, if that is not you. 
• Server administrator 

Colour: You should choose a colour for the calendar. It will be used in the social tree to 
highlight the calendar and will appear as the background of events in the day and month view 
to show they are a part of this calendar. If you don’t choose a colour, a random one will be 
assigned.  
Add/Update: This will add the new calendar or update changes to the existing calendar. The 
changes will only be saved if you have the correct permissions, you will be notified via a 
message box if you don't. 
Cancel: This will cause the calendar to not be created or cancel any change to the existing 
calendar. 
Remove: Only available when the dialogue is in edit mode. This will remove the calendar 
from the server and everyone’s group social tree. This is permanent! 

New/Edit Event 

 
From this dialogue you can create a new event or edit an existing event. It is accessible from 
the File Menu, Toolbar and also by double clicking an existing event or blank space in either 
the day or month view. 
 
Event Title: You must give the event a title this will be displayed on the month and day views. 
It should describe the event and doesn't have to be unique. 
Calendar: You must select a calendar to add the event too. The calendar the event is added 
to will be visible to all members of the calendars social group. An event may only be added to 
one calendar. 
Event start time: You must select a date when the event should occur. 
Event duration: You must select the duration of the event. 
Event description: You may optionally set a description for the event. This will be displayed 
in day view. 



Add/Update: This will add the event to the selected calendar. If the calendar is in read-only 
mode and you are not the group owner or a server administrator the event will not be created. 
Cancel: This will cause the calendar to not be created or cancel any change to the existing 
event. 

List groups 

 
From this dialogue you can see a list of all created groups on the available server. It is 
accessible from the View Menu and Toolbar. 
 
Name: Indicates the name of the group 
Access: Indicates the access restrictions on the group, it is related to the invite only option in 
the New/Edit Group dialogue. If a group is public anyone may join it. If the group is private 
you can only join it if you are a server administrator otherwise you must wait for the group 
owner to invite you. 
Join: Will cause you to join the group selected in the list. 
List Users: This will cause a new dialogue to be displayed which lists all users in the selected 
group. 
Close: This will close the dialogue. 

List groups users 

 



From this dialogue you can see a list of all users in a group. It is accessible from the List 
Groups dialog and by New/Edit Group dialog. 
 
Username: Indicates the name of the user. 
Invite User: Allows you to invite another user on the server to the group. Only the group 
owner (creator) or a server administrator can add users to the group. 
Kick User: Will cause the selected user to be removed from the group. Only the group owner 
(creator) or a server administrator can remove users from the group. 
Close: This will close the dialogue. 

List users 

 
This dialogue displays a list of all user accounts on the server along with their access 
permissions. 
 
Username: Indicates the name of the user. 
Access: Either Regular or Admin. Admin users don't have to obey any rules set by group 
owners such as not being able to join private groups or creating events in read-only groups. 
Close: This will close the dialogue. 
 
The following commands are only available to server administrators. 
 
Add User: Allows the administrator to create a new account. A unique username and 
password will be requested. 
Del User: Will remove the selected user account the server. 
Set Password: This will change the selected user's password to a password selected by the 
administrator. 
Give Admin: Give administrator privileges to an account. 
Take Admin: Remove administrator privileges from an account 

Change Password 

 
This dialogue will allow you to change your password it is important that it is changed 
regularly so that your account is kept secure. 
 
Old password: In order to change your password you must enter your current password, this 
is to stop malicious users changing the password of accounts that are left logged in. 



New password: Choose your new password. 
Confirm new password: You must confirm your password to prevent accidental account 
lockouts and typos. 
OK: Saves your changes, if your old password was incorrect or the new passwords are then 
a message box will be displayed. 
Cancel: Don't save any changes to your password and close the dialogue. 

Frequently Asked Questions 

Where can I find a server to connect to? 
You can either setup your own server by downloading the server off our website. Although its 
very simple to setup you will need a computer running Linux. If you don't feel comfortable with 
this or are feeling lazy(!) you can join one of the public servers listed on our website. 

Why do I need to install Java and where can I get it from? 
Java allows software to be written on one computer and then run on many others. Minneola 
Client is written in Java so that you can enjoy it on as many computers as possible. 
 
You can check if you have Java installed on your computer by visiting 
http://www.java.com/en/download/installed.jsp. If you find its not installed you can download it 
from http://www.java.com/en/download/. 

Help, I've forgotten my password. How can I get access to my account? 
Get in contact with one of the server administrators for your Minneola server and ask them to 
reset if for you. 

How did this project start? 
This project was initially started as a second year university group project at Bristol University 
by four computer scientists. 

Why are you crazy about Minneolas and fruit in general? 
Every piece of software has a mascot or a theme. Sun has coffee and we have fruit! We 
aren't crazy, we just think its tasty, honest! 

I'm a developer and I'd like to help your project 
The project has two branches the server and client. If you'd like to get involved don't hesitate 
to get in contact with us via e-mail or on the forum. Javadoc is available for the API and other 
client classes. 
 

http://www.java.com/en/download/installed.jsp
http://www.java.com/en/download/
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